Getting Started
With Your PowerBook G4

Includes setup, expansion, and troubleshooting information for PowerBook G4 computers
Contents

1 Getting Started  5
   Plugging In the Computer  6
   Opening the Display  7
   Turning the Computer On  8
   Moving Items on the Screen  9
   Adjusting the Internal Display  10
   Where to Go From Here  12
   Calibrating Your Battery for Best Performance  12
   What to Do When You Are Finished Working  13

2 Getting to Know Your Computer  15
   Basic Features of Your PowerBook  16
   Additional Features of Your PowerBook  18
   Inside Your PowerBook  20
   Sherlock 2—Your Internet Search Detective  22
   iTools—Free Internet Services for Mac Users  24
   Apple.com—Your Starting Place on the World Wide Web  26
   QuickTime—Audio and Video on the Internet  28
   iMovie 2—Create and Edit Your Own Digital Movies  30
   iTunes—Digital Music For Your Mac  32
   Auto Updating—Automatically Keep Your Mac on the Cutting Edge  34
   Multiple Users—Turn One Mac Into Many  36
   Mac Help—Answers to All Your Macintosh Questions  38

3 Using Your Computer  39
   Universal Serial Bus (USB)  40
FireWire  42
PC Cards  44
AirPort Wireless Internet and Networking  45
Ethernet (10/100Base-T)  46
Infrared (IrDA)  47
External Video Support (VGA and S-Video)  48
Battery  51
DVD Drive  54
Keyboard Controls and Programmable Function Keys  56
Security Slot and Keyboard Lock  58

4 Working Inside Your Computer  59
Installing Additional Memory  60
Installing an AirPort Card  67

5 Troubleshooting  75
Information in This Chapter  75
Problems That Prevent You From Using Your Computer  76
Other Problems  78
Locating Your Product Serial Number  78

Appendix A
Specifications  79
Apple System Profiler  79
PowerBook Specifications  80

Appendix B
Care, Use, and Safety Information  83
Cleaning Your PowerBook  83
Carrying Your PowerBook  83
Storing Your PowerBook  83
Safety Instructions for Setting Up and Using Your Computer  84
General Safety Instructions  85
Ergonomics  86
Getting Started

Your PowerBook has been designed so that you can set it up quickly and start using it right away. If you have never used a PowerBook or are new to Macintosh computers, read this section for instructions on getting started and where to get more information.

If you are an experienced user, you may already know enough to get started. Be sure to look over the information in Chapter 2, “Getting to Know Your Computer,” to find out about the new features of this PowerBook.

Important  Read all the installation instructions and safety information (see page 83) carefully before you plug your computer into a wall socket.
**Plugging In the Computer**

Plugging in the power adapter recharges the computer’s battery. You should plug in the power adapter in case the battery has been drained during shipping or storage.

1. Plug one end of the power cord into the power adapter and the other end into an outlet.
2. Plug the power adapter plug into the power adapter port (marked with the icon ⚡) on the back of the computer.

**Warning**

Do not connect a digital telephone line to the modem, because the wrong type of line could damage the modem.

---

**Connecting the Internal Modem**

If you want to connect to the Internet right away, connect one end of the phone cord to the internal modem port (marked with the icon ⚡) and the other end to an analog telephone line (the type of telephone line found in most residences).
Opening the Display

1. Push the display release button.

2. Open the display and position it at a comfortable viewing angle.
Turning the Computer On

To turn on the computer, press the Power button (). You should hear a tone when you turn on the computer. It takes the computer a few moments to start up.

Problems Turning the Computer On?

Nothing happens when you press the Power button.
- The battery may be drained. Make sure that you plugged in the power adapter, and that the adapter is firmly connected to both the computer and a power source.
- If the computer still doesn’t start up when you press the Power button, use the tip of a pen to press the reset button (see page 18) on the back of the computer. Wait a few seconds and then press the Power button again.
- If the computer still doesn’t start up, see page 77.

There is a slight delay before the computer starts up.
- This is normal. When you press the Power button, the PowerBook checks its memory before it starts up. The more memory installed, the longer the delay.

You see a picture of a disk or a folder with a blinking question mark.
- This icon usually means that the computer can’t find system software on the hard disk or any disks attached to the computer. You may need to reinstall system software. See page 76.
Moving Items on the Screen

You use your PowerBook trackpad to move items and select items on the screen, much as you use a mouse with a desktop computer. To move the arrow pointer on the screen, slide your finger across the trackpad. To select, click, or double-click an item on the screen, use the trackpad button.

Note: Instead of using the trackpad button, you can click and double-click directly on the trackpad. You turn on this option in the Trackpad control panel.

The trackpad is sensitive to how quickly you move your finger. To move the pointer a short distance across the screen, move your finger slowly across the trackpad. The faster you move your finger, the farther the pointer moves on the screen.

Tips for Using the Trackpad

For best results when using the trackpad, keep in mind these tips:

- Use only one finger. Do not use a pen or any other object.
- Keep your finger and the trackpad dry. If the trackpad becomes moist from humidity or condensation, gently wipe it with a clean cloth before you use it.
- Never use any kind of cleaning solution on the trackpad.

For more information on using the trackpad, see Mac Help or Mac Tutorials, available in the Help menu.
Adjusting the Internal Display

Before you begin working with your new PowerBook, you may need to adjust your display so that items on the screen are easy to see.

Adjusting the Brightness

Use the keys labeled with the † icon to adjust screen brightness.
**Adjusting the Display Resolution**

You can increase the size of images on your display by switching from the standard resolution to a scaled resolution. Click the Resolution icon in the Control Strip.

<table>
<thead>
<tr>
<th>Open Monitors Control Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color LCD</strong></td>
</tr>
<tr>
<td>640 x 480</td>
</tr>
<tr>
<td>720 x 480</td>
</tr>
<tr>
<td>800 x 600</td>
</tr>
<tr>
<td>896 x 600</td>
</tr>
<tr>
<td>1024 x 768</td>
</tr>
<tr>
<td>1152 x 768</td>
</tr>
</tbody>
</table>

**About the Resolutions Supported by the Built-In Display**

Your PowerBook has a wide screen display with a native resolution of 1152 x 768 that also supports standard resolutions such as 1024 x 768. When you use a standard resolution, a black band appears on each side of the display.

*Note:* Most applications automatically switch to the best resolution for the application.

You may want to use a standard resolution when mirroring your display on an external monitor or when using certain applications (such as games or presentation software) that are designed for a standard resolution.

*Note:* If you use an application designed for a standard resolution and do not want to see the black bands, you can choose the “stretched” version of the resolution to stretch the image to cover the entire screen and eliminate the black bands. To access additional stretched resolutions, hold down the Control key when you click the Resolution icon in the Control Strip.

You can choose a resolution of 896 x 600 or smaller in the Control Strip and Monitors control panel. These are known as “scaled resolutions.” When you switch to a scaled resolution, items on the screen appear larger, making them easier to see. However, scaled resolutions may not be as sharp as the display’s native resolution.
Where to Go From Here

You’ve done everything you need to get your PowerBook up and running. The first time that you turn your computer on, the Macintosh Setup Assistant takes you through the process of configuring your computer and setting up for the Internet.

If you would like additional information, see the following:

<table>
<thead>
<tr>
<th>To learn about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shutting down your computer or putting it to sleep</td>
<td>“What to Do When You Are Finished Working” on page 13.</td>
</tr>
<tr>
<td>What you can do with the hardware and software features of your PowerBook</td>
<td>Chapter 2, “Getting to Know Your Computer.”</td>
</tr>
<tr>
<td>The additional information available in the onscreen help</td>
<td>“Mac Help—Answers to All Your Macintosh Questions” on page 38.</td>
</tr>
<tr>
<td>Using a specific feature of your PowerBook</td>
<td>Chapter 3, “Using Your Computer.”</td>
</tr>
<tr>
<td>Installing memory or an AirPort Card</td>
<td>Chapter 4, “Working Inside Your Computer.”</td>
</tr>
<tr>
<td>What to do if you have a problem with your PowerBook</td>
<td>Chapter 5, “Troubleshooting.”</td>
</tr>
</tbody>
</table>

Calibrating Your Battery for Best Performance

To get the longest running time from your PowerBook battery, let the battery run down and then fully charge it one time. Follow these steps:

1. Plug in the power adapter and fully charge your PowerBook battery until the battery indicator lights and the onscreen meter (see page 52) indicate that the battery is fully charged.

2. Disconnect the power adapter and use your PowerBook until you see the first low battery warning.

3. Connect the power adapter and leave it connected until the battery is fully charged again.

Important You only have to fully discharge and then charge your battery once to calibrate it. After that, you can connect and disconnect the power adapter when the battery is at any charge level.
What to Do When You Are Finished Working

When you have finished working with your PowerBook, you have two options.

**Put Your PowerBook to Sleep**

If you will only be away from your PowerBook for a short time, put the computer to sleep. When the computer is in sleep, you can quickly wake it and bypass the startup process. When the computer is in sleep, its screen is dark and a small white light below the display pulsates.

To put the computer to sleep quickly, do one of the following:
- Close the display.
- Choose Sleep from the Special menu.

**Warning** Wait a few seconds until the sleep light starts pulsating (indicating that the computer is in sleep and the hard disk has stopped spinning) before you move your PowerBook. Moving your computer while the hard disk is spinning can damage your computer.

To wake the computer:
- If the display is closed, open it. Your PowerBook wakes from sleep when you open the display. (You can turn off this option in the Energy Saver control panel.)
- If the display is already open, press the Power button (⌘) or any key on the keyboard.

**Shut Down Your PowerBook**

If you will not use your PowerBook for a day or two, shut it down. Do one of the following:
- Choose Shut Down from the Special menu.
- Press the Power button and click Shut Down in the dialog box that appears on the screen:

![Are you sure you want to shut down your computer now?](image)

**Note:** If you plan to store your PowerBook for an extended period of time, see “Storing Your PowerBook” on page 83 for additional steps to prevent your battery from completely draining.
Getting to Know Your Computer

If you’re eager to get started and want to try out a few things on your PowerBook, this chapter is for you. It provides an overview of your computer’s hardware and software features along with the unique Internet services available to Mac owners.

Out of the box, your PowerBook is a full-featured notebook computer. It includes the latest in computer technology such as a PowerPC™ G4 processor, FireWire, USB, and support for AirPort wireless Internet and networking. On top of this hardware runs the Mac OS operating system. Included with the Mac OS are powerful features that allow you to use the Internet to watch video, research information, shop, and even update your software automatically.

With your PowerBook you also get iMovie, an easy-to-use digital video editing application that lets you use your PowerBook to create desktop movies. Simply connect a digital video camera to the FireWire port on your PowerBook, open iMovie, and you’re ready to create your own movies.

On top of all this, Apple provides you with free Internet services that give you storage space on the Internet, a personal Mac.com email address, tools to easily create your own Web site or iMovie theater, and more.

If You Are New to the Mac

If this is your first Macintosh computer, start with the Mac Tutorials (see page 38) to learn how to use the trackpad to move items on the screen, go to a site on the World Wide Web, and more. To access the tutorials, choose Mac Tutorials from the Help menu.

In This Chapter

Here you’ll find a great selection of your computer’s features presented and briefly explained. Take a test drive and see what your PowerBook can do.

Note: Because Apple frequently releases new versions and updates to its system software, applications, and Internet site, images shown in this manual may be slightly different from what you see on your screen.
Basic Features of Your PowerBook

- Built-in speaker/microphone
- Power button
- Security slot
- AirPort antenna window
- Sleep indicator light
- Trackpad
- Display release button
- Slot-loading DVD-ROM drive
- Keyboard release tab
- Volume controls
- Num Lock key
- Programmable function keys
- Media Eject key
- Brightness controls
- Keyboard lock
- Mute control
- Keyboard release tab
Brightness controls
Increase or decrease the brightness of your PowerBook display using these keys on your PowerBook keyboard.

Volume controls
Increase or decrease the volume of the sound coming from the built-in speakers and sound output port.

Mute control
Turn the sound from the PowerBook built-in speakers and sound output port off and on.

Keyboard lock
Protect the internal components of your PowerBook by preventing the keyboard from being easily opened.

Num Lock key
Activate the numeric keypad embedded in the PowerBook keyboard.

Media Eject key
Press this key to eject a CD or DVD disc.

Power button
Turn your PowerBook on and off or put it to sleep.

Slot-loading DVD-ROM drive
Use the DVD-ROM drive to install and run programs, play music CDs, play DVD-Video discs, or reinstall system software. To eject a disc, drag the disc’s icon to the Trash or use the Media Eject key on the keyboard.

Function (Fn) key
Press and hold this key to activate the function keys (F1–F12).

Keyboard release tabs
When you need to access the internal memory slots, pull these tabs down to release the PowerBook keyboard.

Microphone
Record sounds directly on your PowerBook hard disk with this built-in microphone (located under the speaker cover). You can also connect an external microphone to one of the USB ports or use a professional microphone that connects to a PCMCIA Card.

Security slot
Protect your PowerBook by connecting a security cable.

Sleep indicator
A white light pulsates when the PowerBook is in sleep.

Trackpad
Move the pointer on the PowerBook display. With the Trackpad control panel, you can set the trackpad to double-click and select items directly instead of using the trackpad button.
Additional Features of Your PowerBook
FireWire port
Connect high-speed external devices, such as digital video cameras, printers, and external storage devices.

Ethernet port (10/100 Base-T)
Connect to a high-speed 10/100Base-T Ethernet network or connect to another computer and transfer files.

Two USB (Universal Serial Bus) ports
Connect additional equipment to your PowerBook, such as printers, external storage devices, modems, keyboards, and joysticks.

External monitor (VGA) port
Connect to an external monitor or projection device that uses a VGA-style connector.

TV out (S-video out) port
Connect your PowerBook to a television, VCR, or other video device. You can use TV out for presentations or to play a DVD-Video on your television.

PowerBook reset button
Reset the computer with this button when you cannot shut it down using the Power button.

Internal modem port
Connect a standard phone line directly to the internal modem.

Infrared window
Use infrared (IR) communication to send files to another IR-equipped computer, print on an IR-equipped printer, or connect to an IR network that uses the IrDA standard. You can also use IR to synchronize with certain handheld personal assistants or use a cellular telephone (where applicable) to connect to your Internet service provider.

Headphone port
Connect external speakers, headphones, or other sound output device.

PC Card slot
Expand the capabilities of your PowerBook using this Type II PC Card slot that supports both PCMCIA and CardBus formats.
Inside Your PowerBook

**PowerBook with the keyboard flipped over and internal RAM slot visible**

- Upper memory slot
- Lower memory slot (filled)
- Keyboard flipped over

**PowerBook turned over with the bottom case removed**

- Battery
- Bottom case
- AirPort Card slot
- AirPort antenna
- Serial number
- Ethernet ID
Memory slots
Your PowerBook comes with two memory slots, one above the other. The lower slot contains the memory module that came with your PowerBook. You can install an additional memory module in the upper slot. (If you ordered your PowerBook with additional memory, the upper slot may already be filled.) The maximum amount of RAM you can install in your PowerBook is 1 gigabyte (GB), using a 512 megabyte (MB) memory module in each slot. For instructions, see “Installing Additional Memory” on page 60.

Optional AirPort Card
Installing an AirPort Card in your computer allows access to a wireless network. For instructions, see “Installing an AirPort Card” on page 67.

AirPort antenna cable
The end of the built-in AirPort antenna attaches to the end of the optional AirPort Card.
Sherlock 2—Your Internet Search Detective

Sherlock channels
Search the Internet for people, shopping, news, Apple info, and more.

Search button
After you type what you are looking for, click this button to start the search.

Search sites
Search engines that Sherlock uses to search the Internet.
What You Can Do
Sherlock 2 is your search detective and personal shopper on the Internet. It provides an easy way to find people, news, and just about anything. Shop for books and music and search auction sites, find the best prices—even check product availability.

To Get Started
1. Connect to the Internet.
2. Choose Search Internet from the File menu or double-click the Sherlock icon on the desktop.
3. Select a Sherlock channel.
4. Type what you are looking for and click the Search button.

Tips and Tricks
Create your own customized Sherlock search channel
1. Choose New Channel from the Channels menu.
2. Select a name, channel type, and icon.
3. Download Sherlock plug-ins and drag them into the search site list. Or hold down the Option key and drag plug-ins from the other search lists to the icon of your new channel.

To Learn More
To learn more about what you can do with Sherlock, open Mac Help and search for “Sherlock.” To download additional search plug-ins and find out how you can create your own Sherlock plug-in, go to the Sherlock Web site at www.apple.com/sherlock
iTools—Free Internet Services for Mac Users

Email
Get your own Mac.com email address. It’s easy and free, and it works with your favorite email clients.

KidSafe
KidSafe makes the Internet a safer place for your kids. KidSafe gives them access to more than 75,000 educator-approved Web sites and blocks all the rest.

iDisk
With your very own 20 megabyte storage space on Apple’s Internet server, iDisk is the easy way to share files over the Internet. Using iDisk, you can easily share photos and movies, as well as import them into your own Web site.

HomePage
Build your own personal Web site in three easy steps. Create a birth announcement, résumé, or photo album, or set up your own iMovie theater. Apple will even host your Web site on its Internet server, so it’s always there for the world to see.
What You Can Do

iTools is a new class of Internet services from Apple created exclusively for Mac users. With iTools, you can get your own Mac.com email address, make the Internet safer for your children, and share photos and movies. You can even create your own Web site.

To Get Started

1. Connect to the Internet.
2. Go to www.apple.com
3. Click the iTools tab and then click the Free Sign Up button.

Tips and Tricks

Upload pictures to your iDisk to create custom iCards
You can send iCards with your own custom pictures. Save your images as GIF or JPEG files and then copy them to the Pictures folder on your iDisk. Your images will appear as picture choices when you create an iCard in the Create Your Own section.

Start with a HomePage template to create your own Web page in minutes
HomePage has Web page templates that you can modify with your own text and images. For example, teachers can use the HomePage education templates to post recent class news, homework assignments, and other information for parents. You can also use the HomePage photo album and iMovie templates to share your pictures and movies easily with your friends and family.

Create an alias of your iDisk for easy access
Instead of connecting to the Web manually to open your iDisk, you can select the icon of your iDisk and choose Make Alias from the File menu. Whenever you want to access your iDisk, double-click the alias and enter your password.

Use KidSafe in conjunction with the Multiple Users control panel
Use the Multiple Users control panel to set up your computer for your entire family to share. Then set up KidSafe for each of your children’s accounts.
Apple.com—Your Starting Place on the World Wide Web

Mac OS X
www.apple.com/macosx
Get the latest info on the world’s most advanced OS—Mac OS X.

iCards
www.apple.com/icards
Use the Internet to send greeting cards to your friends and family.

Macintosh Products Guide
www.apple.com/guide
For great hardware and software products for your Mac, check this Web site or look for the Mac symbol.
Apple Support
www.apple.com/support
Find the latest troubleshooting information, download software updates, find information on product protection plans, and more.

Apple Hot News
www.apple.com/hotnews
Want the latest Apple news straight from the source? Check out Apple Hot News. You can find information on software updates for your Mac and third-party software, QuickTime hot picks, and information on the next big Apple event.

The Apple Store
www.apple.com/store
Your one-stop shop for the latest Apple hardware and software products, including select software and accessories from third-party developers.
QuickTime—Audio and Video on the Internet

Volume control

Play button

Favorites drawer

Quick access to all of your QuickTime TV channels. Pull the tab at the bottom to open and close the Favorites drawer.
What You Can Do
In addition to playing video and music files on your Mac, with QuickTime you can watch live and recorded Internet broadcasts.

To Get Started
1 Connect to the Internet.
2 Double-click the QuickTime Player icon on the desktop.
3 Open the Favorites drawer.
4 Select a channel.

Tips and Tricks
Add additional QuickTime TV channels
Go to www.apple.com/quicktime and click the QuickTime TV link. There you will find all of the available QuickTime channels. You can watch a QuickTime TV channel and with one click add it to the Favorites drawer in QuickTime Player.

Upgrade to QuickTime Pro to do the following:
- Play back full-screen video and resize movies.
- Create streaming movies.
- Work with more than 30 audio, video, and image formats, including Flash.
- Create, open, edit, and save movies and audio, as easily as copying and pasting.

To Learn More
Internet video is just one of the things you can do with QuickTime. To learn more, start with QuickTime Help. To download additional channels, watch the latest movie trailers, and find information on setting up your own Internet streaming server, go to the QuickTime Web site at www.apple.com/quicktime
iMovie 2—Create and Edit Your Own Digital Movies

iMovie monitor
Preview your movie or view video directly from a connected DV camcorder.

Mode switch
Use this to switch between importing from a camcorder and editing.

Timeline viewer
The clip viewer and the timeline viewer are visual aids for assembling and editing your movie.

Playback controls
Use these to play the movie in the iMovie monitor.

Scrubber bar
Use this to select sections of video.

Shelf
To make clips part of your movie after you import them, drag them from the shelf to the clip viewer.

Editing buttons
Click these to open panels for adjusting and selecting sounds, video effects, titles (text), and transitions. Click the Clips button to see the shelf.

Video track
Lets you work with audio contained in video clips.

Audio tracks
 Lets you work with recordings, music, and sound effects.

Playhead
Represents the location of the frame showing in the iMovie monitor. Move the playhead to see where things appear in a movie.
What You Can Do

iMovie is an easy-to-use digital video editing software application. With iMovie and a digital video camcorder, you can create and edit your own movies. Import video from the camera, edit clips, add transitions, titles, sound effects, and music. Then copy the movie to a camcorder tape or create a QuickTime movie.

To Get Started

1. Shoot your video, connect the camera to your computer’s FireWire port, and then open iMovie.
2. Click the Import button to import movie clips to the shelf, then add them to your movie by dragging them to the clip viewer.
3. Assemble and edit your movie in the clip viewer and timeline viewer.
4. Add transitions, titles, sound, and music.
5. When you are finished, choose Export from the File menu.

Tips and Tricks

Share your desktop iMovie with your friends and family

Export your movie as a QuickTime Web movie and copy the movie to your iDisk. Then use HomePage to create your own iMovie theater so that others can view your movie on the Internet.

To Learn More

For more information on using iMovie, see the iMovie Tutorial or iMovie Help. For the latest on iMovie, including iMovie updates, additional plug-ins, and a list of compatible DV camcorders, go to the iMovie Web site at www.apple.com/imovie
iTunes—Digital Music For Your Mac

Radio Tuner
Listen to hundreds of Internet radio stations—jazz, rock, talk, and more.

Audio CDs
Play an audio CD on your computer. Import songs to your library.

Portable music
Transfer songs to an MP3 player by dragging songs from your library.

Search
Type in some text and iTunes lists song titles that match.

Eject CD button

New Playlist button
Create a personalized playlist using songs from your library.

Visuals button
Have iTunes display a stunning light show that changes, throbs, and pulses to the beat of your music. Enjoy different colors and patterns every time you listen to a song.
What You Can Do
iTunes lets you import songs from music CDs as MP3 files, create playlists, move music to your portable MP3 player, listen to hundreds of radio stations on the Internet, and more.

To Get Started
1. Open iTunes (located inside the Applications folder on your hard disk).
2. Insert a music CD into your DVD drive.
3. Click the checkbox next to the songs you want to import.
4. Click the Import button. Your songs are converted into MP3 files and stored in your iTunes library.

Tips and Tricks
Create playlists for your favorite sets of songs
iTunes lets you create playlists from songs in your library. A playlist is a list of songs in a specific order. Use your playlists to program your music for specific moods, artists, or themes. Click the New Playlist button and drag songs from your library to the playlist.

Resize the iTunes window or access iTunes from the Control Strip
You can collapse the iTunes window to show just the playback controls and status. Click the zoom box in the upper-right corner of the iTunes window. You can also access iTunes controls from the iTunes Control Strip module.

Look up CD information from CDDB
iTunes connects to the CDDB database on the Internet automatically to look up the name of the CD, song titles, and other information about your music CD. If you are not connected to the Internet, you can look up information on songs you imported the next time you connect. Select the song and choose Get CD Track Names from the Advanced menu.

Connect your PowerBook to your stereo system
You can easily connect your PowerBook to your stereo system. Use a miniplug-to-RCA cable (not included) to connect the headphone port (дор) on your PowerBook to the audio input ports on your stereo.

To Learn More
For more information on using iTunes, see iTunes Help or go to the iTunes Web site at www.apple.com/itunes
Auto Updating—Automatically Keep Your Mac on the Cutting Edge

Update Now
Instantly check Apple’s Internet servers to see if any updates are available for your software. The Software Update control panel displays all of the updates useful for keeping your computer running smoothly.

Set Schedule
Set the day of the week and time of day to check automatically for software updates.
What You Can Do
Auto updating uses the Internet to download (and even install) the latest updates, drivers, and other enhancements from Apple—automatically. You can even set your Mac to check Apple’s server periodically and download and install updated software for you.

To Get Started
1. Connect to the Internet.
2. Choose Control Panels from the Apple menu and then choose Software Update from the submenu.
3. Click the Update Now button.
4. Select the software you want to update and then click Install.

Tips and Tricks
Adjust your Software Update schedule
If you have an Internet connection that is always on, you can set a schedule for your computer so that it checks for software updates at a certain time on specific days of the week. If you have a dialup connection and you are not connected, Software Update will check the next time you connect.

Install new software automatically
You can set up your Mac so that every week it checks for and installs the latest software. Set a schedule for your computer to check for software updates and deselect the “Ask me before installing new software” checkbox.

To Learn More
For more information on using Software Update, search for “Software Update” in Mac Help. For the latest information on the Mac OS, go to the Mac OS Web site at www.apple.com/macos
Multiple Users—Turn One Mac Into Many

Accounts
Set the appearance of the user’s environment. If you want to control the user’s access to certain applications, choose Limited or Panels.
What You Can Do

With Multiple Users, you can allow up to 40 users to share a single Mac with their own customized settings and private storage space. For example, users can set their own desktop picture, sort their views the way they like, bookmark favorite Web sites, and do many other things that create, in effect, a personalized Mac for each individual user. You can also specify how much access—and liberty to change things—each individual user can have.

To Get Started

1. Choose Control Panels from the Apple menu and then choose Multiple Users from the submenu.
2. Turn Multiple User Accounts on.
3. Click the Options button to configure overall multiple user settings such as the Welcome message and other options.
4. Click the New User button.
5. Edit the user’s information, access privileges, and applications.
6. Close the Multiple Users control panel.

Each time the computer starts up, the login window appears. To go back to the login window after another user has already logged in, choose Log Out from the Special menu.

Tips and Tricks

Create a voice print passphrase

Record yourself speaking a phrase, such as “My voice is my password.” Your Mac stores your voice print for comparison. Later, when you log in by speaking your passphrase, your Mac analyzes the biometrics of your voice to make sure you are who you say you are.

To Learn More

For more information on setting up Multiple Users, including creating a voice print passphrase, search for “Multiple Users” in Mac Help. For the latest information on the Mac OS, go to the Mac OS Web site at www.apple.com/macos
Mac Help—Answers to All Your Macintosh Questions

Got a question? Type it here and click Search.
Using Your Computer

Your PowerBook has many built-in features and expansion capabilities you can use to customize and expand your computer to fit your needs. These include the following:

- Universal Serial Bus (USB) for connecting additional equipment to your PowerBook, such as printers, scanners, joysticks, keyboards, digital cameras, and floppy disk drives.
- FireWire for connecting high-speed equipment, such as digital video cameras and external hard disks.
- The latest in communications technologies, such as a 56K modem, infrared, 10/100Base-T Ethernet, and optional AirPort wireless Internet and networking.
- The ability to use your PowerBook with an external monitor, video projector, or television, including support for video mirroring and creating an extended desktop. Use your PowerBook’s built-in video support to do presentations, work with an external monitor, or play DVD-Video discs on your television.
- Long-lasting battery, one Type II PC Card/CardBus slot, and more.

To learn about what you can do with your PowerBook, start with the information in this chapter. Additional information can be found in Mac Help (see page 38) and on Apple’s many Internet Web sites.
Universal Serial Bus (USB)

Your PowerBook comes with two USB ports, which you can use to connect many types of external devices, including printers, scanners, digital cameras, game pads, joysticks, keyboards, and hard disk drives. USB makes it easy to connect external equipment. In most cases you can connect and disconnect a USB device while the computer is running. Once you connect the device, it is ready to use. You don’t need to restart or reconfigure your computer.

Using USB Devices

To use a USB device with your computer, simply connect the device to the computer. Your computer automatically loads the correct software whenever you attach a new device.

Note: Apple has already included software to work with many USB devices. When you connect a USB device, if your PowerBook cannot find the correct software, you can either install the software that came with the device or follow the onscreen prompts to use the Internet to locate, download, and install the correct software.

USB Devices and Battery Power

USB devices, such as joysticks and keyboards, that get power from the USB connection instead of a separate power adapter can be used with your PowerBook. However, these types of USB devices can cause your PowerBook battery to become depleted faster. If you are going to have a device connected for an extended period, it is a good idea to plug in the power adapter.
Using Multiple USB Devices at the Same Time

Your PowerBook has two USB ports. If you want to use more than one device on the same USB port, purchase a USB hub. The USB hub connects to an open port on your computer and provides additional USB ports (usually four or seven).

For More Information on USB

Additional information on USB is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “USB.” You can also find information on Apple’s USB Web site at www.apple.com/usb

For information on USB devices available for your computer, check the Macintosh Products Guide at www.apple.com/guide
FireWire

Your computer has one FireWire port. FireWire lets you easily connect and disconnect external high-speed devices—such as digital video (DV) cameras, printers, scanners, and hard disks. You can connect and disconnect FireWire devices without restarting your computer.

These are some of the things you can do with FireWire:

- Connect a digital video camera and capture, transfer, and edit high-quality video directly on your computer using video editing software such as iMovie.
- Connect an external FireWire hard disk drive and use it to back up data or transfer files. A FireWire hard disk icon appears on your desktop immediately after you connect the drive to your PowerBook.
- Start up from an external FireWire hard disk. Connect an external FireWire disk (with a valid System Folder installed on it) and then select the disk in the Startup Disk control panel. (To access the control panel, choose Control Panels from the Apple [ 文件 ] menu and then choose Startup Disk from the submenu.)
- If you want to transfer files between computers or have a problem that prevents your computer from starting up, you can use FireWire to connect your PowerBook to another FireWire-equipped computer so that your PowerBook will appear as an external hard disk on the other computer (a feature known as FireWire target disk mode).

Using FireWire Devices

To use a FireWire device with your computer, connect the device to the computer and install any software that came with the device. Your computer automatically senses when you attach a new device.
FireWire Devices and Battery Power

FireWire devices, such as certain external hard disks, that get power from the FireWire connection instead of a separate power adapter can be used with your PowerBook. However, these types of FireWire devices can cause your PowerBook battery to become depleted faster. If a device will be connected for an extended period, it is a good idea to plug in the power adapter.

FireWire Target Disk Mode

If you want to transfer files or have a problem that prevents your computer from starting up, you can use FireWire to connect your PowerBook to another computer so that your PowerBook will appear as an external hard disk on the other computer.

**Important** The computer you connect your PowerBook to must have FireWire version 2.3.3 or later installed. Use Apple System Profiler, available in the Apple menu, to check the version of FireWire installed. If you have an older version, check the Apple FireWire Web site at www.apple.com/firewire

To connect your PowerBook in FireWire target disk mode, follow these steps:

1. Make sure that your PowerBook is shut down.
2. Use a FireWire cable with a standard 6-pin connector on each end to connect your PowerBook to another FireWire-equipped computer.
3. Start up your PowerBook and immediately hold down the T key.
   Your PowerBook display shows the FireWire logo, and the PowerBook internal hard disk icon appears on the desktop of the other computer.
4. When you are finished transferring files, drag the PowerBook hard disk icon to the Trash.
5. Press the Power button on the PowerBook to shut it down and then disconnect the FireWire cable.

For More Information on FireWire

Additional information on FireWire, including setting up a network of FireWire devices, is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “FireWire.” You can also find information on Apple’s FireWire Web site at www.apple.com/firewire. For information on the FireWire devices available for your computer, check out the Macintosh Products Guide at www.apple.com/guide
PC Cards

You can expand your computer’s capabilities using the PC Card slot. Your PowerBook has one PC Card slot that accepts Type I and Type II PCMCIA cards, including CardBus-format cards. You can insert a PC Card when your computer is on, off, or in sleep.

Inserting and Ejecting a PC Card

When inserting a PC Card, make sure the label is facing up and the card is level. You’ll feel some resistance as you slide the card in. When the card is firmly seated in the slot, it clicks into place and an icon appears on the desktop. You can eject a PC Card when your computer is on or off, but not when it is in sleep.

To eject a PC Card:

1. If the computer is turned on, drag the card’s icon to the Trash.
2. Push the PC Card eject button once to release the button.
3. Push the button again to eject the card.
4. Pull the card out of the slot and then push the eject button again to set it flush against the computer.

Important The Apple AirPort Card is installed in a slot inside your computer. It does not go in the PC Card slot the way many third-party wireless cards do. The AirPort Card will not work if it is installed in the PC Card slot and will cause your computer to function improperly.

For More Information on PC Cards

For information on the PC Cards available for your PowerBook, check out the Macintosh Products Guide at www.apple.com/guide
AirPort Wireless Internet and Networking

Your PowerBook is AirPort-ready. AirPort offers an easy and affordable way to provide wireless Internet access anywhere in the home, at work, or in the classroom. Instead of using traditional cables, AirPort uses wireless local area network (LAN) technology to provide wireless communication between multiple computers. Through a wireless network you can set up access to the Internet, transfer files, play multiplayer games, and more.

*Note:* Wireless Internet access requires an AirPort Card, AirPort Base Station, and Internet access (fees may apply). Some Internet service providers are not currently compatible with AirPort, including America Online. Range may vary with site conditions.

How AirPort Provides Wireless Internet Access

With AirPort, you set up a wireless connection to a device known as a *base station*, which has a physical connection to the Internet. The base station can be an external device or another computer with an AirPort Card installed (known as an *AirPort software base station*). AirPort technology works like a cordless telephone. The AirPort Card in the computer makes a wireless connection to the base, which is connected to the telephone line.

For More Information on AirPort

To purchase an AirPort Card or AirPort Base Station, contact your Apple-authorized dealer or go to the Apple Store at www.apple.com/store. For instructions on installing an AirPort Card, see page 67.

Additional information on AirPort is available in AirPort Help. Choose Help Center from the Help menu and click the AirPort Help link. You can also find information on Apple’s AirPort Web site at www.apple.com/airport.
Ethernet (10/100Base-T)

Your computer comes with built-in 10/100 megabit per second (Mbps) twisted-pair Ethernet networking capability, which you can use to connect to a network or to a cable or DSL modem.

Connecting to a network gives you access to other computers. You may be able to store and retrieve information, use network printers, modems, and electronic mail, or connect to the Internet. You can also use Ethernet to share files between two computers or set up a small network.

**Note:** Use category 5 Ethernet cables to connect to a 100Base-T Ethernet network.

**For More Information on Using Ethernet**

Additional information, including setting up an Ethernet network and transferring files using Ethernet, is available in Mac Help (see page 58). Choose Mac Help from the Help menu and search for “Ethernet” or “network.”

For information on networking products you can use with your PowerBook, check the Macintosh Products Guide at www.apple.com/guide
Infrared (IrDA)

Because your PowerBook is equipped with infrared (IR), you can exchange files and data without using wires. The type of IR used is the industry-standard IR communication method known as IrDA.

You can use infrared to share files with another IrDA-equipped computer, communicate with other infrared devices such as handheld organizers, connect to an infrared network, and even print on an infrared printer. Sharing files using infrared is the same as sharing files using Ethernet, except that AppleTalk and TCP/IP are set to Infrared instead of Ethernet.

Note: You cannot share files with a computer that only supports IRTalk (a non-standard IR communication method used by some older computers).

Making an Infrared Connection

To connect to another computer using infrared:

1. Position the IR windows of the two computers so that they are directly facing and within 3 feet of each other.
2. Configure AppleTalk and TCP/IP to communicate using infrared.
3. Make sure that file sharing is turned on in the File Sharing control panel.

For More Information on Infrared

Information on configuring the Mac OS to communicate using infrared and setting up file sharing is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “infrared” or “file sharing.”
External Video Support (VGA and S-Video)

Your computer has a monitor port that allows you to directly connect a monitor with a VGA-style adapter or other external video device such as a video projector.

The TV out port (also known as an *S-video out port*) on your computer lets you connect to a television, videocassette recorder (VCR), or video projection system using either an S-video or composite video cable (available at your local electronics store). You can use TV out to display images on a television, record computer images on a VCR, or play DVD-Video discs on your television (see page 54).

*Note:* If the device you want to connect does not have S-Video, you can use the Composite-to-S-video adapter that came with your PowerBook.

When an external monitor or television is connected, you can either have the same image appear on both the internal display and the external monitor (known as *video mirroring*) or use the external monitor to extend the size of the Mac OS desktop (known as *extended desktop mode*).

*Note:* Because of the display limitations of most televisions, images displayed on the television screen will be of lower quality than those on the built-in display or an external monitor.
Connecting an External Monitor

To connect an external monitor to your computer:

1. Shut down your computer or put it to sleep and turn off the external monitor.
2. Connect the monitor cable to your PowerBook.
3. Turn on the external monitor.
4. Start up or wake your computer.
5. Use the Resolution portion of the Control Strip to change resolutions on the external monitor. For information on the supported external monitor resolutions, see page 81.

By default, your PowerBook starts up in extended desktop mode. You can use the Video Mirroring portion of the Control Strip to make the images on the PowerBook display and the external monitor the same.

Note: In addition to the Video Mirroring control module you can install the Video Mirroring App (located in the CD Extras folder on your system software CD) and assign it to a function key (see page 56). When assigned, you can quickly switch between extended desktop mode and video mirroring by pressing a single key.

Using Your PowerBook With the Display Closed

You can use your PowerBook with the display closed if the computer is connected to an external monitor, keyboard, and mouse.

To operate your computer with an external monitor attached and the display closed, do the following:

1. Connect a USB keyboard and mouse to your PowerBook.
2. Close the PowerBook display to put the computer to sleep.
3. Follow the steps in the previous section to connect your PowerBook to an external monitor.
4. Wait a few seconds and then press any key on the external keyboard to wake the PowerBook.

Note: If your external USB keyboard has a Power button, you can shut down your PowerBook and start it with the display closed by pressing the Power button (instead of having it wake from sleep as described in the steps above).
Connecting a Television, VCR, or Other Video Device

To connect a device to the TV out port:

1. Shut down your computer or put it to sleep and turn off the external device.
2. Connect an S-video cable to the TV out port (Æ) on your PowerBook (or use the adapter to connect a composite video cable) and connect the other end to your device.
3. If you want to send the sound from your PowerBook to the device, connect a miniplug-to-RCA cable (not included) from the headphone port (f) on your PowerBook to the audio input ports on your device.
4. Turn on the external device.
5. Start up or wake your computer.
6. Use the TV Mirroring portion of the Control Strip to adjust how the images are displayed on the device.

For More Information on Using an External Monitor or TV

Additional information on using and configuring an external monitor is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “monitor.”
Battery

When the external power adapter is not connected, your computer draws power from its battery. You can determine the charge left in your battery by looking at the battery level indicator lights on the battery itself. The lights glow to show how much charge is left in the battery. The indicator lights remain lit for a few seconds after you press the button.

**Important** If only one flashing light is on, very little charge is left. If no lights are visible, the battery is completely drained and the computer will not start up unless the power adapter is connected. Plug in the power adapter for several hours to let the battery recharge.

Removing and Replacing the Battery

To remove the battery:

1. Shut down your PowerBook, turn it over, and locate the battery release latch.
2. Slide the latch down and gently remove the battery.
Swapping Batteries While the Computer Is in Sleep

If your battery runs low while you are working, you can put your PowerBook to sleep and replace the battery with a charged one. The internal backup battery provides enough power to maintain the contents of RAM for about one minute.

**Important** If your computer has 512 megabytes (MB) or more of memory installed, the backup battery maintains the contents of RAM for less than a minute. If you have more than 512 MB of memory installed, save your work and shut down your computer before you swap batteries.

Charging a Battery

When the power adapter is connected, the battery is recharged whether the computer is off, on, or in sleep. However, the battery will recharge more quickly if the computer is off or in sleep. You can monitor the battery charge level using the Control Strip.

To maximize the life of your PowerBook battery, use the power adapter whenever possible.

Calibrating a New Battery for Best Performance

To get the longest running time from a new PowerBook battery, let the battery run down and then fully charge it one time. Follow these steps:

1. Plug in the power adapter and fully charge your PowerBook battery until the battery indicator lights and the onscreen meter indicate that the battery is fully charged.
2. Disconnect the power adapter and use your PowerBook until you see the first low battery warning.
3. Connect the power adapter and leave it connected until the battery is fully charged again.

**Important** You only have to fully discharge and then charge your battery once to calibrate it. After that, you can connect and disconnect the power adapter when the battery is at any charge level.
Battery-Saving Tips

The amount of work time your PowerBook battery can provide before you need to recharge it depends on the equipment you’re using with your computer and the steps you take to conserve power while you work.

To save battery power, do one or more of the following:
- Disconnect bus-powered USB or FireWire devices when they are not in use.
- Quit open applications that you are not using.
- Remove CD-ROM and DVD-ROM discs when they are not in use.
- Reduce screen brightness using the brightness control on the PowerBook keyboard.
- Use a lighter desktop pattern.
- Close the display to put the computer in sleep whenever your work is interrupted.

Additional options are available in the Energy Saver control panel and Control Strip module:
- Set the hard disk to spin down after a short time.
- Set your PowerBook to sleep after inactivity of five minutes or less.
- Make sure that processor cycling is turned on.
- Set your processor to operate at a slower speed when using non-processor-intensive applications such as a word processor. (Operating at a slower speed conserves battery power. However, it may affect performance of processor-intensive applications, such as DVD playback.)

Use the Energy Saver Control Strip module to easily access your computer’s energy settings.

For More Information on Your PowerBook Battery

Additional information is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “battery.”
**DVD Drive**

All the software necessary to use your computer and connect to the Internet is already installed on your PowerBook. (You need to use the PowerBook CDs that came with your computer only if you are having problems and need to reinstall system software.) However, if you purchased additional software with your PowerBook, you can install or run programs from CD and DVD discs using the DVD drive.

**Note:** If you have older software that comes on floppy disks, contact the software manufacturer to see if the software is available on a CD-ROM disc or purchase a third-party external floppy disk drive (such as an LS120/SuperDisk) from your Apple dealer or the Apple Store (www.apple.com/store).

**Inserting Discs**

To install or use programs from a CD or DVD disc, follow these steps:

1. With the computer turned on, insert the disc (with the label facing up) into the drive slot until you feel the drive catch the disc and take it the rest of the way in.

2. When the icon for the disc appears on the desktop, the disc is ready to use.

**Important** Your PowerBook DVD drive is designed to work with standard size CD and DVD discs. Irregularly shaped discs will not work and may damage your computer.
Ejecting a Disc From the DVD Drive

You eject a disc by dragging the disc icon to the Trash or pressing the Media Eject (⏏) key on the keyboard.

If you can’t eject the disc, try the following:

- Quit any applications that may be using the disc and try again.
- Restart your computer and hold down the trackpad button during startup until the disc ejects.
- If that does not work, insert the end of a paper clip into the manual eject hole (located on the far right side of the drive slot) to press the internal eject button. To use the manual eject button, your PowerBook must be turned on.

Playing DVD Discs

You can also use the DVD drive to play DVD-Video discs on your PowerBook. Insert the DVD disc and then choose Apple DVD Player from the Apple () menu.

If you want to use S-video to connect your PowerBook to a TV (see page 48) so that you can watch a DVD-Video on the TV screen, select 720 x 480 NTSC (in the United States) or 720 x 576 PAL (in Europe and other regions) in the Resolution portion of the Control Strip. Then select Best for Video from the TV Mirroring portion of the Control Strip.

Note: When your PowerBook is connected to an external monitor, DVD playback is only available in extended desktop mode. You can drag the DVD window between the external monitor and the built-in display.

You can easily connect your PowerBook to your stereo system. Use a miniplug-to-RCA cable (not included) to connect the headphone port () on your PowerBook to the audio input ports on your stereo.

For More Information on Your DVD Drive

For instructions on using Apple DVD Player, open the player and then choose Apple DVD Player Help from the Help menu.

Additional information on using CD or DVD discs is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “discs.”
Keyboard Controls and Programmable Function Keys

You can quickly adjust settings such as volume and screen brightness and eject a CD or DVD disc using the keyboard controls.

Your PowerBook also has five additional keys that you can set up to open your frequently used applications or documents. These keys are known as *programmable (or hot) function keys*. For example, you can use these keys to open your Web browser, word processor, or favorite game. Once applications are open, you can use the keys to switch quickly between them.

Assigning Programmable Function Keys

The first time you press one of the function keys, a dialog box appears that lets you assign any of the function keys to an application. After that, you can change function key assignments using the Keyboard control panel.

Using the Standard Function Keys

You can quickly change a key from a control or programmable function key to a standard function key by pressing the Fn key while you press the other key. You can also use the Keyboard control panel to reverse the keys so that the standard function keys are primary and the screen controls and programmable function keys are secondary. (You would hold down the Fn key to change the screen brightness, for example.)
Using the Embedded Numeric Keypad

Most desktop computer keyboards have a numeric keypad in addition to the regular keyboard keys. Your PowerBook keyboard has a numeric keypad incorporated in the standard keyboard keys. Keys used for the numeric keypad have a smaller secondary label.

To use the numeric keypad, press the Num Lock key on the keyboard. The light next to the Num Lock key turns on, indicating that the keypad is active. When you’re finished, press the Num Lock key again to turn it off.

Note: When the numeric keypad is active, other keys and keyboard equivalents for menu commands (such as ⌘Q to quit) are deactivated.

For More Information on Keyboard Controls

Additional information on configuring the keyboard controls and programmable function keys is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “keyboard.”
Security Slot and Keyboard Lock

You can purchase a security cable and lock to protect your PowerBook. With a lock, you can secure your computer to a desk or table.

Your PowerBook also comes with a keyboard locking mechanism. When the keyboard is locked, users can't easily access the internal components of the computer, including the memory.

The keyboard locking mechanism is in the small plastic tab to the left of the Num Lock key, which also contains the Num Lock indicator light. Your PowerBook comes with the keyboard unlocked.

To lock the keyboard, use a small flathead screwdriver to turn the screw clockwise 1/2 turn. A small tab prevents the keyboard from being removed.

**Note:** The screw that turns the plastic tab has a small notch on one side that you can use to determine if the keyboard is locked. If the notch in the screw is on the top, the keyboard is unlocked. If the notch in the screw is on the bottom, the keyboard is locked.

For More Information on Security Options

Additional information on the software security features of your PowerBook, including multiple user passwords and file encryption, is available in Mac Help (see page 38). Choose Mac Help from the Help menu and search for “security” or “multiple users.”

**Note:** The Password Security control panel used on older computers is not compatible with your PowerBook and is not installed on your computer.
Working Inside Your Computer

This chapter provides information and instructions for working inside your computer. Instructions are provided for the following procedures:

- “Installing Additional Memory” on page 60
- “Installing an AirPort Card” on page 67

**Warning** Apple recommends that you have an Apple-certified technician install memory or an AirPort Card. Consult the service and support information that came with your computer for instructions on how to contact Apple for service. If you attempt any of these procedures yourself, you risk damaging your equipment, and such damage is not covered by the limited warranty on your computer.
Installing Additional Memory

Your computer comes with two memory slots, one above the other, that you access by removing your PowerBook keyboard. Your computer comes with a 64 or 128 megabyte (MB) Synchronous Dynamic Random-Access Memory (SDRAM) module installed in the lower slot. The upper memory slot can accept a SDRAM module that meets the following specifications:

- Small Outline-Dual Inline Memory Module (SO-DIMM) format
- 1.5 inch or smaller
- 64, 128, 256, or 512 MB
- 144-pin
- PC-100 Type RAM

Note: SDRAM from an earlier PowerBook that meets these specifications can be used with your PowerBook.

The maximum amount of RAM you can install in your PowerBook is 1 GB, using 512 MB DIMMs in both the upper and lower RAM slots.

Installing Additional RAM

1. Shut down your computer. Disconnect the power adapter, phone cord, and any other cables connected to the computer.

2. Flip the computer over and remove the battery.
   This prevents you from accidentally turning on the computer while installing memory.

Warning: The internal components of your PowerBook may be hot. If you have been using your PowerBook, wait 30 minutes after shutting down your computer to let the internal components cool down before continuing.
3 Make sure that the keyboard locking screw is not in the locked position. Your new PowerBook comes with the keyboard unlocked, so unless you or someone else locked the keyboard, you can skip this step.

4 Release the keyboard by pulling down on the keyboard release tabs (located to the left of the F1 and F9 keys) and then lift up on the top portion of the keyboard.
5 Lift the top portion of the PowerBook keyboard up slightly near the top row of keys and pull it back far enough to displace the small tabs that hold the bottom of the keyboard in place.

6 Flip the keyboard over and lay it on the palm rests and trackpad.

7 Touch a metal surface inside the computer to discharge any static electricity.
8 Locate the upper RAM expansion slot.

9 Hold the RAM expansion card at a 30-degree angle. Line up the notch in the card with the small tab in the RAM expansion slot. Then push the RAM expansion card into the expansion slot.

Note: You may feel some resistance. If you have trouble inserting the card, try pushing one side at a time.
10  Gently push the RAM expansion card down until the two snaps on either side of the card lock into place.

11  Flip the keyboard back on top of the opening in your PowerBook and insert the small tabs at the bottom of the keyboard into the openings in the PowerBook case.
12 Pull down on the keyboard release tabs (located to the left of the F1 and F9 keys) and then press down on the top portion of the keyboard.

13 Let go of the keyboard release tabs to secure the keyboard in place.

14 Turn the PowerBook over and replace the battery.

15 Reconnect the power adapter and any other cables that were attached.
Making Sure Your Computer Recognizes the New Memory

After installing additional memory in your PowerBook, check whether the computer recognizes the new memory. Do the following:

1. Start up your computer.
2. When you see the Mac OS desktop, choose About This Computer from the Apple () menu. A window shows the total amount of memory in the computer.

The total includes the amount of memory that originally came with the computer plus the new memory you added. For a more detailed breakdown of the amount of memory installed in your computer, choose Apple System Profiler from the Apple () menu.

If the memory is not recognized or your computer does not start up correctly, shut down your PowerBook and check the instructions again to make sure that the memory you installed is compatible with this PowerBook and that it is installed correctly. If you still have problems, remove the memory and consult the service and support information that came with your computer for instructions on how to contact Apple for service.
Installing an AirPort Card

You can purchase an AirPort Card from your Apple-authorized dealer or from the Apple Store at www.apple.com/store and install it yourself or have it installed by an Apple-authorized service provider.

To install an AirPort Card in your PowerBook, follow these steps:

1. Shut down your computer. Disconnect the power adapter, phone cord, and any other cables connected to the computer.

2. Place a towel or soft cloth on a table in front of you. The towel or cloth will protect the keyboard and display of the PowerBook when you flip it over. Make sure that it covers an area large enough for your PowerBook and that it also hangs over the edge of the table.

3. With the display open, carefully flip the PowerBook over and rest it on the edge of a table. Make sure the weight of the computer is on the table and not on the display.

Important  Do not open the display further than the angle shown above.
4 Remove the battery by sliding the latch to the left. Make sure to return the battery latch fully to the right.

Warning The internal components of your PowerBook may be hot. If you have been using your PowerBook, wait 30 minutes after shutting down your computer to let the internal components cool down before continuing.

5 Using a small Phillips screwdriver, remove the eight screws that secure the bottom case of the PowerBook in the order shown in the illustration below.
6 Carefully slide the bottom case away from you.

7 Pivot the bottom case up as shown in the illustration below.

**Important** Do not twist the case from side to side. Slide the bottom case forward completely before lifting it up. If you feel any resistance when lifting the bottom case, double-check to make sure the bottom case is slid all the way forward and releases from the DVD slot.
8 If your AirPort Card came with the AirPort adapter, remove the metal clip and pull the AirPort Card from the adapter. (The adapter and metal clip are not used with your PowerBook.)

9 Touch a metal surface inside the computer to discharge any static electricity.

10 Disconnect the AirPort antenna from its holder.
11 Position the AirPort Card with the AirPort ID numbers and bar code visible and slide the card into the connector. Slide the card all the way in until you feel that the card is securely attached to the connector.

12 Connect the AirPort Card to the end of the antenna cable. Make sure that the connector on the end of the antenna cable is straight before inserting it into the card. When it is connected, make sure the end of the antenna cable is secured by the small clip shown in the illustration below.

13 Fold the plastic tab on the AirPort Card over the top of the card.

**Important** The plastic tab must be folded over the card. If the tab is not folded over, you will not be able to attach the bottom case securely to the computer.
14 Attach the bottom case to the computer and replace the eight screws in the order shown in the illustration below.

Line up the notches on the right and left sides of the case. Then press down slightly to secure the case. Make sure the seams between the bottom case and the frame are closed. Check the outside edges and around the battery bay. Check the alignment of the eight screw holes to make sure the bottom case is properly positioned.

15 Replace the battery and turn the computer over.
16 Look at the DVD drive slot to make sure that the case is properly secured. If a gap exists below the DVD drive slot, gently pull the bottom of the DVD drive slot toward you to secure the DVD drive to the bottom case and remove the gap.

17 Reconnect the power adapter and any other cables that were attached.
5 Troubleshooting

Occasionally you may have problems while working with your PowerBook. Usually it’s because your software isn’t properly configured or you’re using applications or software extensions that are not compatible with the version of the Mac OS (system software) installed on your computer. Other less likely sources include problems with the Mac OS (usually fixed by reinstalling your computer’s system software or through a software update) and problems with your computer’s hardware, such as the memory or hard disk.

When you experience a problem with your computer, it is important to remember that there is usually a simple and quick solution. When you encounter a problem, be aware of the conditions that led up to the problem. Making a note of things you did before the problem occurred will help you narrow down the possible causes of the problem and then find the answers you need. Things to note include:

- the applications you were using when the problem occurred (Problems that occur only with a specific application may indicate that the application is not compatible with the version of the Mac OS installed on your computer.)
- any software that you recently installed, especially any software that may have added items to the System Folder (Certain applications install extensions that may not be compatible with the version of the Mac OS installed on your computer.)
- any new hardware (such as additional memory or a peripheral) that you installed

Information in This Chapter

This chapter contains solutions to problems that prevent you from working with your computer, such as a system freeze or a computer that will not start up. You can find more troubleshooting information in Mac Help (see page 38) and on Apple’s Support Web site at www.apple.com/support
Problems That Prevent You From Using Your Computer

If the computer won’t respond or the pointer won’t move
- Press the Command (⌘) and period keys at the same time and, if a dialog box appears, click Cancel.
- If that doesn’t work, hold down the Option and Command (⌘) keys and then press the Esc key. If a dialog box appears, click Force Quit. Then save your work in any open applications and restart the computer to be sure the problem is entirely cleared up.
- If you are unable to force the application to quit, press and hold the Power button (⊕) for a few seconds to shut down the computer.
- If the computer still doesn’t respond, try to restart it by simultaneously pressing the Command (⌘) and Control keys on your keyboard and the Power button (⊕).
- If that doesn’t work, locate the reset button (see page 18) on the back panel of your computer. Carefully press the button using the tip of a pen. Then press the Power button (⊕) to restart it.

Note: You may need to reset the date and time (using the Date & Time control panel) after you use the reset button.

If the problem occurs frequently, choose Mac Help from the Help menu. Look at the section on how to prevent and solve problems. You may need to check for extension conflicts or reinstall your computer’s system software. If the problem occurs only when you use a particular program, check with the program’s manufacturer to see if it is compatible with your computer.

If the computer freezes during startup or you see a flashing question mark
- Turn off your system extensions by starting up your computer while holding down the Shift key.
- If that does not work, start up your PowerBook while holding down the C key and at the same time insert your system software CD. (Make sure the Caps Lock key is not engaged.)

After the computer starts up, choose Mac Help from the Help menu. Look at the section on how to prevent and solve problems. You may need to check for extension conflicts or reinstall your computer’s system software.

If using your system software CD is the only way you can start up your PowerBook, you need to reinstall your computer’s system software. For instructions, look in Mac Help or open the software installation or restore program and follow the onscreen instructions.
If the computer won’t turn on or start up

- Make sure the power adapter is plugged into the computer and into a functioning power outlet.
- Your battery may need to be recharged. Press the small button on the battery (see page 51). You should see one to four lights indicating the battery’s level of charge.
- If that does not work, locate the reset button (see page 18) on the back panel of your computer. Carefully press the button using the tip of a pen.
  
  **Note:** You may need to reset the date and time (using the Date & Time control panel) after you use the reset button.
- If that does not work, press the Power button () and immediately hold down the Command (⌘), Option, P, and R keys until you hear the startup sound a second time.
- If you recently installed additional memory, make sure that it is correctly installed and that it is compatible with your computer. See whether removing it allows the computer to start up.
- If you are still unable to start up your computer, see the service and support information that came with your PowerBook for information on contacting Apple for service.
Other Problems

If you have a problem with a software program

- For problems with software from a manufacturer other than Apple, contact the manufacturer. Often software manufacturers provide updates to their software on their Web sites. You can configure your PowerBook to automatically check for and install the latest Apple software using the Software Update control panel. For more information, choose Mac Help from the Help menu and search for ‘software update.’

If you have problems with your Internet connection

- Make sure your telephone line or network cable is connected and functioning properly.
- If you are using a dial-up Internet connection, make sure that your telephone cord is plugged into the modem port (marked with the icon 📞) and not the Ethernet port (marked with the icon 🌐).
- Choose Mac Help from the Help menu. There you will find how to locate your Internet settings and the contact information for your Internet service provider (if you used the Setup Assistant to get your Internet account).

If you have a problem using your computer or working with the Mac OS

- If the answers to your questions are not in this manual, look in Mac Help for instructions and troubleshooting information.
- Check the Apple Support Web site at www.apple.com/support for the latest troubleshooting information and software updates.

If you suspect a problem with your computer hardware

- You can use the Apple Hardware Test CD to help determine if there is a problem with one of your computer’s components, such as the memory or processor.

Locating Your Product Serial Number

The serial number for your PowerBook is located on the inside wall of the battery bay. For instructions on removing the battery, see “Removing and Replacing the Battery” on page 51.
Specifications

This section provides basic product specifications. Additional information is available in Apple System Profiler on your hard disk and on the Internet at www.apple.com/powerbook and www.apple.com/support.

Apple System Profiler

You can use Apple System Profiler to find out detailed information about your specific model of PowerBook, such as the amount of built-in memory, hard disk size, devices connected, and the product serial number.

To access the information in Apple System Profiler:
- Choose Apple System Profiler from the Apple (/apple) menu.
PowerBook Specifications

Processor, Memory, and Hard Disk
- **Processor:** PowerPC G4 processor with a minimum of 400 megahertz (MHz)
- **Note:** Your PowerPC processor can operate at a reduced speed (see page 53) to save battery power. When the reduced processor speed option is enabled, Apple System Proﬁler shows the slower processor speed in addition to the standard speed of the processor.
- **Memory:** Minimum of 128 megabytes (MB); maximum of 1 gigabyte (GB)
- **Hard disk:** Minimum 10 GB

Video Memory and Graphics
- **Video memory:** 8 MB SDRAM
- **Graphics controller:** ATI RAGE Mobility 128

Modem
- **Modem standards:** K56flex and V.90
- **Modem speed:** 53 kilobits per second (Kbps)
- **Note:** Download speeds vary with line conditions and the modem capabilities of your Internet service provider (ISP). FCC regulations limit ISP transmission speeds to 53 Kbps in the United States.

Optional AirPort Card
- **Wireless data rate:** Up to 11 megabits per second (Mbps)
- **Range:** Up to 150 feet (45 meters) in typical indoor use (varies with building)
- **Frequency band:** 2.4 gigahertz (GHz)

Power Adapter
- **Input:** AC 100–240 volts (V), 50/60 hertz (Hz)
- **Output:** DC 24 V, 1.875 A

Battery
- **Output:** DC 14.4 V
- **Capacity:** 3600 mAh
External Monitor in Extended Desktop or Video Mirroring Mode

With the PowerBook G4 display set at 1152 x 768 in millions of colors, an external VGA display supports

- **Up to millions of colors in the following resolutions:** 512 x 384, 640 x 480, 640 x 870, 800 x 600, 832 x 624, 1024 x 768, and 1152 x 870
- **Up to thousands of colors in the following resolutions:** 1280 x 960, 1280 x 1024, and 1600 x 1200

**Note:** Selecting a resolution greater than 1152 x 768 in video mirroring mode causes the image on the external monitor to scale down (not take up the entire screen) to match the 1152 x 768 resolution of the internal display.

External Monitor in Display Closed Mode

- **Up to millions of colors in the following resolutions:** 640 x 480, 800 x 600, 1024 x 768, 1152 x 870, 1280 x 960, 1280 x 1024, and 1600 x 1200
- **Up to thousands of colors in the following resolutions:** 1792 x 1344 and 1856 x 1392

External S-Video or Composite Television (NTSC)

- **Up to millions of colors in the following resolutions:** 512 x 384, 640 x 480, 720 x 480 (NTSC only), 800 x 600, 832 x 624, and 1024 x 768 at 60 Hz

External S-Video or Composite Television (PAL)

- **Up to millions of colors in the following resolutions:** 512 x 384, 640 x 480, 720 x 576, 800 x 600, 832 x 624, and 1024 x 768 at 50 Hz

**Note:** Playback of DVD movies on an external monitor or television reduces the amount of video memory available for display. Fewer colors may be available at certain higher resolutions.

Size and Weight

- **Height:** 1.0 in. (26 mm)
- **Width:** 13.4 in. (341 mm)
- **Depth:** 9.5 in. (241 mm)
- **Weight:** 5.3 lbs. (2.4 kg)

**Note:** Weight varies depending on configuration and manufacturing process.

Operating Environment

- **Operating temperature:** 50°F to 95°F (10°C to 35°C)
- **Storage temperature:** −13°F to 140°F (−25°C to 60°C)
- **Altitude:** 3048 m (10,000 ft.) maximum
- **Shipping altitude:** 10668 m (35,000 ft.) maximum
- **Relative humidity:** 20% to 80% noncondensing
Care, Use, and Safety Information

Cleaning Your PowerBook
Follow these general rules when cleaning the outside of your computer and its components:
- Use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid getting moisture in any openings.
- Don’t use aerosol sprays, solvents, or abrasives.

Cleaning Your PowerBook Display
To clean your PowerBook screen, do the following:
- With your PowerBook shut down, dampen a clean, soft, lint-free cloth or paper with water only and wipe the screen. Do not spray liquid directly on the screen.

Carrying Your PowerBook
If you carry your PowerBook in a bag or briefcase, make sure that there are no loose items (such as paper clips or coins) that could accidentally get inside the computer through the slot for the DVD drive.

Storing Your PowerBook
If you are going to store your PowerBook for an extended period of time, do one of the following to prevent your PowerBook battery from becoming completely depleted:
- Keep the power adapter connected.
- Fully charge your PowerBook battery before storing the computer.
- Fully charge and then remove your PowerBook battery when storing your computer (especially important when storing your computer for longer than 5 months).
Safety Instructions for Setting Up and Using Your Computer

Plugging in the Power Adapter
Always leave space around your power adapter. Do not use this equipment in a location where airflow around the power adapter is confined. Always disconnect the power adapter and remove the battery before opening the computer to perform procedures such as installing memory or removing the hard disk.

Warning Use only the power adapter that came with your PowerBook computer. Adapters for other electronic devices (including other PowerBook models and other portable computers) may look similar, but they may damage your computer. If your power adapter came equipped with a three-wire grounding plug (a plug that has a third grounding pin), then this plug will fit only a grounded AC outlet. If you are unable to insert the plug into the outlet because the outlet is not grounded, contact a licensed electrician to replace the outlet with a properly grounded outlet. Do not defeat the purpose of the grounding plug!

Connecting a Phone Line to the Internal Modem
Always disconnect the phone cord before opening the computer to perform procedures such as installing memory or removing the hard disk.

Warning Do not connect a digital telephone line to the modem, because the wrong type of line could damage the modem.

Using Your PowerBook
When using your PowerBook or when charging the battery, it is normal for the bottom of the case to get warm. The bottom of the PowerBook case functions as a cooling surface that transfers heat from inside the computer to the cooler air outside. The bottom of the case is raised slightly to allow airflow that keeps the unit within normal operating temperatures.

Warning Never turn on your computer unless all of its internal and external parts are in place. Operating the computer when it is open or missing parts can be dangerous and damage your computer.
General Safety Instructions

For your own safety and that of your equipment, always take the following precautions.

Disconnect the power plug (by pulling the plug, not the cord), remove the main battery, and disconnect the phone cord if any of the following conditions exists:

- You want to remove any parts (leave the cords disconnected as long as the keyboard is open)
- The power cord or plug becomes frayed or otherwise damaged
- You spill something into the case
- Your computer is exposed to rain or any other excess moisture
- Your computer has been dropped or the case has been otherwise damaged
- You suspect that your computer needs service or repair
- You want to clean the case (use only the recommended procedure described earlier)

**Important** The only way to disconnect power completely is to unplug the power cord and phone cords, and remove the battery. Make sure at least one end of the power cord is within easy reach so that you can unplug the computer when you need to.

Be sure that you always do the following:

- Keep your computer away from sources of liquids, such as drinks, washbasins, bathtubs, shower stalls, and so on.
- Protect your computer from dampness or wet weather, such as rain, snow, and so on.
- Read all the installation instructions carefully before you plug your computer into a wall socket.
- Keep these instructions handy for reference by you and others.
- Follow all instructions and warnings dealing with your system.

**Warning** Electrical equipment may be hazardous if misused. Operation of this product, or similar products, must always be supervised by an adult. Do not allow children access to the interior of any electrical product and do not permit them to handle any cables.

**Warning** Never push objects of any kind into this product through the openings in the case. Doing so may be dangerous and result in fire or a dangerous electric shock.
Ergonomics

Keyboard and trackpad

When you use the keyboard and trackpad, your shoulders should be relaxed. Your upper arm and forearm should form an angle that is slightly greater than a right angle, with your wrist and hand in roughly a straight line.

Use a light touch when typing or using the trackpad and keep your hands and fingers relaxed. Avoid rolling your thumbs under your palms.

Change hand positions often to avoid fatigue. Some computer users may develop discomfort in their hands, wrists, or arms after intensive work without breaks. If you begin to develop chronic pain or discomfort in your hands, wrists, or arms, consult a qualified health specialist.

Chair

An adjustable chair that provides firm, comfortable support is best. Adjust the height of the chair so your thighs are horizontal and your feet flat on the floor. The back of the chair should support your lower back (lumbar region). Follow the manufacturer’s instructions for adjusting the backrest to fit your body properly.

You may have to raise your chair so your forearms and hands are at the proper angle to the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a footrest with adjustable height and tilt to make up for any gap between the floor and your feet. Or you may lower the desktop to eliminate the need for a footrest. Another option is to use a desk with a keyboard tray that’s lower than the regular work surface.
**External mouse**

If you use an external mouse, position the mouse at the same height as your keyboard and within a comfortable reach.

**Built-in display**

Adjust the angle of the display to minimize glare and reflections from overhead lights and windows.

You can adjust the brightness of the screen when you take the computer from one work location to another, or if the lighting in your work area changes.

**For more information**

Go to www.apple.com/about/ergonomics
Communications, Telephone, and Modem Regulation Information

For information on FCC regulations, radio and television interference, and telephone and modem information as it relates to this product, see the files in the Communications Regulations folder, inside the Documents folder on your hard disk.

Laser Information

Warning: Making adjustments or performing procedures other than those specified in your equipment’s manual may result in hazardous radiation exposure.

Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.

Your computer is a Class 1 laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets minimum safety requirements. A service warning label is located in a service-accessible area. The labels on your product may differ slightly from the ones shown here.

Class 1 label

Service warning label

Laser Specifications

Laser on pickup unit (when reading a CD)
- Type: Semiconductor GaAlAs laser
- Wavelength: 790 nm
- Power out of objective lens: 3.3 mW
- Beam divergence: horizontal 12° vertical 35°

Laser on pickup unit (when reading a DVD)
- Type: Semiconductor GaAs laser
- Wavelength: 658 nm
- Power out of objective lens: 6 mW
- Beam divergence: horizontal 8.5° vertical 27°

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or communications systems, or air traffic control machines, or for any other uses where the failure of the computer system could lead to death, personal injury or severe environmental damage.

ENERGY STAR®

As an ENERGY STAR® partner, Apple Computer has determined that standard configurations of this product meet the ENERGY STAR® guidelines for energy efficiency. The United States Environmental Protection Agency’s ENERGY STAR® program is a partnership with office product equipment manufacturers to promote energy-efficiency. Reducing energy consumption of office products saves money and reduces pollution by eliminating wasted energy.